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Introducing GPS-X 
 
Welcome to ARTS, an hydraulic analysis/design software package, developed with the needs of water and wastewater 
engineers in mind. It spans the spectrum of hydraulic problems encountered in water and wastewater engineering as 
well as incorporating specific features related to the hydraulic design of wastewater treatment systems. It is operated 
through a user-friendly graphical interface, which will enable you to sketch an outline representation of the hydraulic 
system under consideration. The software then interprets this sketch in order to return a solution to the problem at 
hand.  
 
This demonstration version of ARTS gives you all the features of the full versions of ARTS for 30 days.  The only 
limitation is that file saving and printing functions have been disabled.  Before the 30-day point you can purchase 
ARTS and turn the demo into permanent license.  You do this by selecting File/Register and sending us the displayed 
information.  Using this data we will then generated a permanent keycode that you can enter in the File/Register 
dialog box.  If you go past the 30-day point and wish to install a full version, you need to first uninstall the ARTS 
demo.  Do this using the normal Windows method from Start –Settings - Control Panel – Add/Remove Programs – 
[highlight] ARTS32 [and click the] Add/Remove [button]. 
 
The operational features of the user interface are explained in detail in the full manual available in Adobe Acrobat 
format on your ARTS demonstration CD.  A summary of the applied hydraulics, which underpins the ARTS computer 
coding, is presented in the Appendix of the manual. 
 
System Requirements 
 
ARTS has been designed to run in Windows 95 or later versions and Windows NT 3.51 or later versions and hence you 
must have the appropriate Windows software installed on your PC before you can install and use ARTS.  
 
The ARTS hardware requirements are the same as required for the Windows interface. The recommended minimum 
processor hardware specification is: 
 

 Pentium with 24 Mb RAM (rec 32 MB) 
 90 MHz processor 
 20 Mb disk space 
 NT 4.0 or higher 
 2 button mouse 

 
Installation 
 
The ARTS demonstration program can only be used when it has been installed on your computer’s hard disk. The 
ARTS demonstration program can be installed from the Demonstration CD or downloaded from www.hydromantis.com. 
 
 
Install ARTS from a CD 
 
The following procedure describes how to install ARTS directly to your computer’s hard disk from the supplied CD ROM. 
As with any software, before you install the ARTS software on your PC, you should carry out steps 1 to 3. 
 

1. If you have a back up system, make a back up of your PC. 
 

2. If you are using a virus-detection utility, disable it before running Setup. If you do not disable the utility, 
Setup may conflict with it and not run. 

 
3. Make sure that you close all open applications. This includes applications that run automatically when you 

start Windows, possibly Microsoft Office or a virus-detection utility. 
 



 

 

4. Insert the ARTS DEMONSTRATION CD ROM into your PC. 
 
5. The install procedure should start automatically after a few seconds. If it does not, click on the START 

button, and choose Run. A dialog box appears as in Figure 0.1. 
 
6. In the Open: box, type the letter of the drive that contains the CD ROM, followed by :\ and the word 

setup. For example, type d:\setup 
 
7. Choose the OK button, and then follow the instructions on the 

screen. Setup asks you to close any open applications. If 
applications are open, and you need more information about 
how to close them, choose the Help button. To close Help, 
choose Exit from the File menu in Help. 

 
 
 
ARTS is supplied with an installation procedure which creates a working directory on your hard disk, into which all the 
ARTS files are transferred. 
 
Click the Next button to continue installation. You will be prompted for some user information and details on how you 
wish to configure the software installation; however, all the options can be left at their default values. 
 
Install ARTS from Web Site Download 
 
When you completed the on-line form on our web site you will have downloaded a single file to a folder on your PC.  
The file name will be ARTSwdemo.exe and will be about 8 MB in size. 
 
The procedure to install the ARTS demo is as follows: 
 

1. Navigate to the folder where the ARTSwdemo.exe file is stored. 
 
2. Double-click the file. 
 
3. A dialog box will appear requesting a password for extracting the files.  Enter the password “evalu8”. 

 
 
The files will be extracted and the set-up and installation will proceed automatically.  You have the option to change 
the installation folder. 
 
Where to Start 
 
To begin exploring ARTS, you may want to try some of the automated learning features that come with this 
demonstration version of ARTS (and with the full version): 
 

 ARTS comes with on-line videos that show you how to use ARTS.  These can be found in My 
Documents\ARTS files.  There are three video show available: “Basics”, “Examples 1-10”, and “Examples 
11-20”.  The on-screen video is controlled using a Lotus Screen Cam 
control panel that will appear on your screen as the videos commences.  
Placing the mouse over any of the buttons on the Screen Cam control 
window will bring up a description of the function of that button 
 

 The files for all 20 of the examples shown in the videos have been provided with the demonstration version of 
arts.  Using the Open option in the files directory, find the directory “Examples” (if you used the default 
installation directory, this can be found under C:\Program Files\Aquavarra\Arts\User Files\Examples). 

 

 

Figure 0.1 The Run Dialog box 



 

 

 
 

 Four additional samples that highlight some of the functions of ARTS can also be found in the “Samples” 
directory (if you used the default installation directory, this can be found under C:\Program 
Files\Aquavarra\Arts\User Files\Samples).  These include two wastewater treatment plant examples, a 
waterhammer example, and a reservoir-pipe network. 

 

Sketching the Layout and Setting Properties 
 
 
Notes: 
• Click means press and release the left-hand mouse button quickly; 
• Double-click means press and release the left-hand mouse button twice in quick succession; 
• Drag means move the mouse while holding down the left-hand mouse button; 
 

Placing objects on the design sheet 

To draw an object on the design sheet: 
 

1. Select the desired object type by clicking on its tool button. The selected tool button is depressed and 
remains so until another tool button is pressed. 

 
2. Move the cursor to one of the intended corner positions for the object on the design sheet. The cursor shape 

should be in the shape of a cross-hair. 
 

3. Click and then move the cursor to draw an outline of the object to the required size - the cursor movement 
traces a dotted outline of the object on the design sheet. 

 
4. When the dotted outline is of the required size, click again to place the object on the design sheet. 

 
If the drawn object is a linear element such as a pipe or channel, its terminal points are identified by a pair of small 
squares, known as selection handles; if it is a process unit such as a tank or pump, its drawn outline space is 
identified by a set of 4 selection handles when the object is selected. 

Selecting objects 

To select one object: 
 

 If the selection tool is not already selected, click on the selection tool  
 

 Click on the object you wish to select 
 

 Small black squares appear at the extremities of the selected object to indicate that it is selected 

 
Not selected 

 

 
Selected 

 



 

 

 
 
To select several objects: 
 

 If the selection tool is not already selected, click on the selection tool  
 

 Drag across the objects you wish to select, enclosing them in the dotted selection rectangle which appears. 
The starting point of a selection rectangle must not be at the same place as one of the objects on the sheet 

 
 Small black squares appear at the extremities of each of the selected objects to indicate that they are selected 

Re-sizing objects 

To re-size an object: 
 

 Select the object you wish to resize 
 

 Place the cursor over one of the selection handles, the cursor changes shape to a double-headed arrow 
 

 Drag to re-size 

Moving objects 

 
To move an object: 
 

 Select the object or objects that you wish to move 
 
 Place the cursor over the object, a small 4-headed arrow appears to the bottom right of the cursor arrow 

 
 Drag to move to a new location. 

Deleting objects 

 
To delete an object: 
 

 Select the object or objects that you wish to delete 
 

 Press the Delete key on the keyboard or 
 

 Choose Delete from the Edit menu 

Drawing hydraulic systems 

 
Pipes and channels: 
 
Both pipes and channel convey fluid from one point to another and can both be regarded as links. An individual link is 
defined by the locations of its end points. Any link that starts or terminates at the end point of another link is 
considered to be connected to that link. Pipes and channels should start and end either in another object or at the end 
of another link. If you try connecting links to the very edge of other objects, ARTS may not register the connection. 
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Figure 0.1 Connected pipes 
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Figure 0.2 Unconnected pipes 

 
Other hydraulic objects: 
  
Treatment process units 
 
These objects should not be placed in other objects. Links are deemed to be connected to a process unit such as a 
reservoir or biofilter, if one of the link’s end points is located within the area enclosed by the outline of the process 
unit. In Hydraulic profile analysis each unit can only have two connections (one in and one out). In Steady pipe 
flow and Unsteady pipe flow analysis, reservoirs can have multiple connections. 
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Figure 0.3 One inflow and one outflow pipe 



 

 

Pumps 
 
ARTS uses the standard graphical representation of a rotodynamic pump, which 
distinguishes its suction/inflow and delivery/outflow points (the central line represents 
inflow, the tangential line represents outflow). Basically, think of a pump as having 2 
small pipes coming out from it (one on each side) onto which you connect your links. 

PU 1

 
Figure 0.4 Pump with one inflow and one outflow pipe 

 
Supply/demand: 

 
The flow object is used to represent either an inflow/supply or an outflow/demand. 
 
To indicate an inflow/supply at a pipe or channel junction: 
 

 Draw the flow object on the sheet with the arrow pointing towards the junction (start the drawing process 
at a point away from the junction). 

 
To indicate an outflow/demand at a pipe or channel junction: 
 

 Draw the flow object on the sheet with the arrow pointing towards the junction (first mouse click at the 
junction). 

 
Note: The flow object can only be used at junctions i.e. it cannot be connected directly to a process unit. All flow 
objects which are not connected to junctions will be ignored. 
 

 

Figure 0.5 Inflow 

 

Figure 0.6 Outflow 



 

 

 
Exercise 
 
Draw the systems illustrated in Figures 2.7 by using reservoir, pipe and pumps. 

 
 
 

 

 
 
 
 
 
 
 
 
 
 

Continuity check 

When you have completed your layout sketch of the hydraulic system, you can check that the connectivity of its 
elements has been correctly interpreted by the software by running the Compile command from the Analysis menu. 
On completion of the compilation process, ARTS places a solid circle over each registered junction according to the 
following colour coding: 

 
1. pipe-to-pipe junctions are represented by a red circle 
 
2. a green circle is placed at each junction which has registered an inflow or outflow 

 
3. a blue solid circle is placed at all other junctions (channel-to-channel, pipe-to-process unit, pipe-to-channel) 

that have been registered by the compilation process. 
 
A correctly registered system should comply with the foregoing colour coding and each compiled node should be 
represented by a single solid coloured circular dot.  
 
Deviation from the foregoing requirements at any node indicates that its junction connectivity has not been correctly 
registered by ARTS i.e. the terminal points of the elements that meet at the junctions are not sufficiently close for 
ARTS to conclude that they are connected. 
 
Connectivity faults can be corrected by repositioning the objects on the design sheet. 
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Figure 0.7 Pumping system - system creation exercise 



 

 

 
 
 

 
 
 
 
 
 
 
 
 
 
 

 

Setting Properties 

 
Every hydraulic object that you place on the design sheet has properties associated with it. These properties are 
accessible via dialog boxes known as Property Pages. For example, a pipe object has a length property, a diameter 
property, a surface roughness property etc. When you place an object on the design sheet you are essentially creating 
a virtual version of a real world object. For example, when you place a pipe on the screen and then display its 
Property Pages, you will find that the pipe has a value for length, diameter as well as its other properties. You will 
probably have to change these values in order represent the element of the real world system you are trying to model. 
Objects that have not had their initial properties changed are drawn in grey on the design sheet.  
 
 
To access the properties of any object, 
 

 select the object and then, 
 

 press the properties tool button on the tool palette. 
 
Alternatively, click on the object with the RIGHT mouse button. A menu should 
appear over the object. Select Properties from this menu. The Property Pages 
for every object have a similar layout. The Property pages for pipe objects are 
displayed in Figure 0.9. 

Changing Units of Measure 

 
SI is the default units system in this ARTS demonstration.  To change the default units system: 
 

 Select Options under the Tools menu at the top of ARTS 
 

 Set the units default by selecting the corresponding units system 
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Figure 0.8 Pumping system - Compile exercise (all nodes 
blue, except marked) 

 

Figure 0.9 Pipe property pages 



 

 

 
Alternatively, you may change the units for specific data entries.  Point to the units indicator (e.g., over (m) beside 
the word Length in Figure 2.9) and then click.  You will be given a list of viable units to choose.  Select the appropriate 
unit. 

Performing System Analysis 

 
All objects can be used individually to design an individual object. Not all the objects can be used with all the analysis 
functions. For example, Air Vessels can only be used in Unsteady pipe flow analysis and will be ignored by the other 
analysis functions. 
 
Exercise 1 
 
Calculate the headloss in a pipe, having an ID of 605mm and a surface roughness of 0.06mm, at a flow of 0.3m³/s. 
The pipe length is 3,459m and it includes four 90º short-radius bends. 
 

 
Step 1  Step 2 
Draw a pipe on the design sheet (the pipe 
will be grey until you set some of it’s 
properties) 

 

 Edit the Length, Roughness, and 
Diameter on the Main property page: 
 

 
 
 

Step 3  Step 4 
a) Add the 90º bends on the 

Extras page from the drop 
down boxes for the Fitting 
type.   

b) Enter the Chainage and 
Elevation.  Hit the Add 
button as each fitting 
definition is completed: 

 

 

 Click on the Status page 
 

 

 
Solution: The headloss through this pipe is 4.6m at 0.3m³/s. 



 

 

 
 
 
 
Exercise 2 
 
An old rising main is 6580m long and has an internal diameter of 345mm. Under normal steady state operational 
conditions, the flow has been measured at 100 l/s and the corresponding headloss has been measured at 19.5m. 
Compute the effective pipe wall roughness.  
 
 
Step 1  Step 2 
Draw a pipe on the design sheet 
(the pipe will be grey until you 
set some of it’s properties) 

 

 Edit the Main property page: 
 

 
 
 

Step 3  Step 4 
Click on the pipe calculator tool 

 
 

 Set the parameters (you will need to change 
the units for Flow and Headloss) on the pipe 
calculator dialog and press “k value” 
 

 
 

Solution: The effective k value is 0.1414mm. 
 
 
 
Exercise 3 
 

 Construct a pipe system similar to that shown on Figure 0.1 on your design sheet. Figure 0.1 shows a 
trunk and branch pipe system, as it would appear on the design sheet after compilation; it includes five 
pipe elements, 3 demands, an upstream reservoir plus an additional supply. 
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 click on the Compile command in the Analysis menu; the pipe system nodes are now highlighted by 

coloured circles (pipe-to-pipe junctions are red, inflow/outflow nodes are green, all other nodes are blue). 
Note that each pipe junction should be represented by a single coloured circle. If there are two coloured 
circles at a pipe junction, or the colour coding is not correct, the junction is not correctly registered by 
ARTS and a correction must be made (Chapter 3). 

 
 select each pipe element in turn (first click the selection tool and then click the drawn pipe element) and 

edit its values for diameter, length and surface roughness, using the property pages so that each pipe is 
100m long, with a surface roughness of 0.01mm and a diameter of 100mm. 

 
 select each supply and demand in turn and edit its value; edit the current flow value to 0.01m3/s. 

 
 Click on the Steady Pipe Flow command on the Analysis menu to compute flow and pressure 

distribution. The computed flow and head values are printed on the design sheet, as are the flow 
directions, as shown in Figure 0.2. 

 

 

Figure 0.1 Network system 
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Figure 0.2 Solved Network system 



 

 

 
Exercise 4 
 

 Draw the system shown on Figure 3.3 on your design sheet 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 compile your system (Compile command on the Analysis menu) and make any corrections necessary. 

 
 make the following changes to the system values: 
 reservoirs: change the downstream reservoir level (R2 in Figure 3.3) to 200.00m (check that the 

upstream sump level is 100.00 m) 
 suction pipe (P1 in Figure 3.3): use the Extras page of its property box to add a 90o elbow bend at 5m 

Chainage. 
 delivery pipe (P2 in Figure 3.3): use the Extras page of its property box to add a non-return valve (at 2 

m Chainage), a gate valve (at 5 m Chainage) and a 90o elbow bend (at 8 m Chainage). 
 rising main (P3 in Figure 3.3): set its length as 500m and internal diameter to 200mm. 

 
 use the Steady Pipe Flow command on the Analysis menu to compute the pump duty point 

 
 check the duty point head, efficiency and required NPSH by entering the duty flow in the flow text box on 

the Status property page for the pump. 
 
 
Exercise 5 
 
Calculate the normal depth in a concrete U-shaped channel, which has a base width of 1500mm, a gradient of 1 to 
1500 and is used to convey sewage at a flow rate of flow 1.65m³/s 
 
 

Step 1  Step 2 
Draw a channel on the design sheet 
(the channel will be grey until you set 
some of it’s properties) 

 Edit the Main property page by 
changing the depth and width of the 
channel: 
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Figure 3.3 Pump system 



 

 

 

 
 
 

Step 3   
Click on the Status page and change 
the flow to 1.65m³/s. 
 

 

  

 
 

Solution: The normal depth is 1085mm at 1.65m³/s. 
 
Exercise 6 
 
Determine the water surface profile in a parabolic channel with the following properties: 
 

length (m)    25 
width (mm)    2000 
height (mm)    1500 
k-value (mm)    1 
bottom slope    1:1200 
end inflow (m3/s)   1.5 
lateral inflow (m3/s)   0.1 
outlet end control depth (mm)  850 

 
 

 
 
 
 
 
 
 
 



 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 3.4 Plot from exercise 6 

Closure 
 
The exercises in this Demonstration Manual touch on a small fraction of the analyses that can be conducted with ARTS.  
For more complex examples of open channel flow systems, wastewater treatment plants, and waterhammer analyses, 
please see the examples available in the HELP menu (Select the Help Topics in the Help menu.  Go to the Content 
tab and double click on Examples.). 
 
 


